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For a list of all reports/queries and specific user guides, navigate to:


SABHRS Documentation > Financials > Reporting 
Setting File Types 
This step is only required on older computers and is optional, however, in order for your query or report results to be viewable in “real” Excel or Word (without a browser window), you will need to ensure that the file types are set to browse in the same window. This process should only need to be completed once on your computer, unless you change computers. 

To edit the file type settings, navigate to:


Start > Settings > Control Panel
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From the Control Panel, open the folder titled “Folder Options.” Click the “File Type” tab and wait for a list of file types to be displayed (this may take several seconds as the system scans your computer for all file types). 
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Scroll down the list of file types and select “XLS” (listed under the Extensions column). Click the Advanced button and remove the checkmark from the select box titled “Browse in same window.” Repeat these steps for DOC and RTF file types, if desired, and close out of the window.

Running a Report

Overview

All reports:

· Can be scheduled (this is encouraged to avoid heavy use during core hours); 

· Can be scheduled with recurrence (to run over and over again)

· Can be distributed, even after the report has run successfully

· Are available in the report repositories for five calendar days

To run standard reports, follow these five basic steps:

1. Select the report to run and create (or select) a Run Control ID.

2. Enter parameters of the desired report (i.e., chartfields to include, dates, etc.). 

3. Run the report. 

4. Check the status of the report. 

5. View, print, or save the resulting data. 

Step 1 – Run Control ID

Because running a report is a process, a Run Control ID is required in order for the system to return the information you have requested in the form of a report. A Run Control ID is a database record that tells the system what settings you want for the report. There are no limits on how many Run Control IDs you may have, and it is strongly suggested that you create a unique Run Control ID for each type of report you run. Once you have created and saved a Run Control ID, you may re-use the Run Control ID for the processes and reports in that module. 

Navigate to the report you want to run and select an existing Run Control ID or add a new one. 

To add a new Run Control ID
· Click the Add a New Value tab

· Enter a name for the run control (no spaces allowed)

· Click the Add button


To select an existing Run Control ID

· Click the Search button on the Find an Existing Value tab

· Select the desired Run Control ID by clicking the name 
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Note: Run Control ID names may not contain spaces – you will need to either run the words together or use the Underscore ( _ ) instead of a space. For example, you could name the run control for a budget status report “budget_status,” or “budgetstatus.”
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Once you have selected (or added) a Run Control ID, the Run Control page appears:
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Step 2 – Enter Report Parameters

On this page, you will enter parameters for the required and optional fields. Fields with an asterisk (*) by the name are required fields. In this report example, the Business Unit and Ledger Group fields are required. By default, the Business unit field will populate with your agency’s identifier. You can, however, override this entry by either typing in another business unit or selecting one from the lookup list. Click the lookup icon [image: image6.bmp] next to any field to display a list of valid values for that field. 

Many of the reports in the system have a Refresh button [image: image7.png]Refresh



 on the Run Control page. Clicking this button will expand the run control options and make chartfield selection options visible, allowing you to more fully customize your report to provide the information you want to see. Run controls are dynamic, and very powerful. You can select many options, including:

· The order in which the selected fields appear on the report;

· The values or range of values you wish to display on the report; and 

· Which fields you want to automatically provide subtotals.

You must select the chartfields you want included in your report, and the way in which those fields are displayed. Be sure to click the Refresh button to ensure that the options available to you are displayed. You can select or de-select any field by clicking the select box next to each field. Clicking the box one time will place a checkmark in the box; clicking the box again will remove the checkmark. If your agency is using Chartfield 1/2/3, you can include those fields in your report by selecting them here. 
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Only those fields you have selected will appear on your report. If your report is blank, check to be sure you selected the desired chartfields. 

The Sequence field allows you to indicate the order in which you want the selected fields to appear. To change the order of appearance, simply type the number of the order you want that field to appear. 

To display subtotals for a particular chartfield simply check the Subtotal box for the Chartfield you want to see subtotaled on the report. 
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The Value and To Value columns can be used to more specifically define your report. For example, if you only want Fund Codes starting with 02 displayed, you can designate those limits here. The wildcard character (%) cannot be used in these fields to indicate a partial value. You must enter valid values or leave these fields blank to retrieve all information for the fields selected. 

Once you have selected the report parameters, you can save it by clicking the Save button [image: image9.png]& save



. Saving the run control is not necessary; however, note that after saving, the selected fields are sorted according to the sequence order entered, and the number in the sequence column disappears for those fields not selected.

Click the Run button [image: image10.png]Run



 to go to the Process Scheduler Request page. 

Step 3 – Process Scheduler

The Process Scheduler allows you to choose from a number of options, including:

· When the report will run, 

· How often the report will run (covered later under the Recurrence section),

· To whom the report will be distributed (who has access to the report), and

· In which format the report will be displayed. 
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By default, the current date will display in the Run Date field. To run the report the same day, leave the current date as displayed. To run the report on a different day, enter a future date by either typing the desired date or selecting it fro the calendar. You must click the calendar icon [image: image12.bmp] in order to choose a date from the calendar. 

The current time is the default time displayed in the Run Time field. If you want a report to run immediately, leave the default time setting. To schedule a report to run at a future time, enter the desired time, along with a.m. or p.m. To set the time, it is not necessary to type the seconds, just the hour and minutes. Designate whether you wish the report to run in the morning or afternoon by typing am or pm without punctuation or spaces (e.g., 12:15pm, 6:00am, 11:45am, etc.). If you use military time (e.g., 1130, 1600, or 0830), it is not necessary to indicate am or pm.

The Process List displays a list of processes currently pending. If only one process is listed, it will automatically be selected. However, if more than one process is listed, you must select the process you wish to run by clicking the associated select box.  
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Report Output Type

Output type tells the system where you want to view the report. Select one of the three options available from the Type dropdown list. The output options are as follows:

Web:
The report is sent to both the Process Monitor and the Report Manager. Web is the recommended output type. 

Window: 
A new window will open, displaying the report. The report can still be accessed through the Process Monitor and Report Manager. 
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Note: If a distributed report is run to a window, the report will only appear in a window for the one running the report; those on the distributions list will not see the report appear in a pop-up window until they open the file to view it.

Email:
The report will be distributed in an email (be careful if running a large report so that the file size does not exceed email limitations).  

Report Format Type

Select an output option from the Format dropdown list. The Format determines the output format for the report. Refer to the Financials Report Output Options user guide (see Appendix) to determine the best format based on the type of report you are running, and what you intend to do with the data once the report has run. The formatting options available for each report are based on the process type. Options available for SQR and Crystal reports include:

SQR

· PDF (Portable Document Format) – View in Adobe Acrobat; document is read only. 

· LP (Line Printer) – View as a text file in DocuAnalyzer, Textpad, or Notepad (no formatting included). 

· CSV (Comma Separated Variable) – View in Excel (no formatting included). 


Crystal

· PDF (Portable Document Format) – View in Adobe Acrobat; document is read only. 

· RTF (Rich Text Format) – View in Word. 

· XLS (Microsoft Excel) – View in Excel (no formatting included).

· TXT (Text File) – View as a text file in DocuAnalyzer, Textpad, or Notepad (no formatting).  

Report Distribution (Optional)

To send a report to another user(s), you can enter distribution information upon completion, the report will be delivered to the recipients you specify via the report repositories. Click the Distribution link to display the Distribution Detail page. 
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The recipients of the report are listed below the Distribute to section. By default, your user ID is listed first because you are the person requesting the report. If you wish to grant access to other users, click the Add a Row icon [image: image15.bmp] to insert additional rows, one row for each user. You will always select the ID type of “User” when distributing your report to others. 
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Select the User ID of the additional recipients by typing it into the Distribution ID field or use the looking button to search for the User ID. You may also use the Outlook address book to find a user’s ID (listed as “Alias”) on the General tab of the address book entry. 

Once all recipients have been selected, click the OK button [image: image17.png]


 to return to the Process Scheduler Request page. 

Even if you did not distribute the report to another user initially (when first scheduling the report), you can grant access to other users after the report has run successfully. To grant access to another user, navigate to the Report Manager, click the Administration tab, click the Details link, and add a row to the distribution list. Select the user’s ID and click the OK button. To delete a user’s access click the Delete a Row button [image: image18.bmp] next to the user’s ID and click the OK button [image: image19.png]


. Clicking the Cancel button will return you to the Process Scheduler page. 

After you’ve completed the Process Scheduler page and the Distribution (optional), click the OK button to run the report. Note that a Process Instance number will appear in the upper right of the page, under the Run button. 
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[image: image71.wmf]If you run numerous variations of the same report on a regular basis, this number will be the only way for you to distinguish one report from another. 
Step 4 – Check Report Status

Reports cannot be viewed until the status displays “Success” or “Posted,” depending upon how you check the Status. Report status can be checked both through the Process Monitor and the Report Manager. 

The Report Manager acts as a personal “in-box” of reports and processes. Through the Report Manager, you can check the progress of your report request, view report content, and manage the history of all reports that were run for the previous five days (calendar days, not working days), including those reports that were run for you by someone else. 

The Process Monitor allows you to view the progress of your report request (even those that did not complete) and to view the completed report, but will not list those reports that were run for you by someone else. 

To check your report status through:

Process Monitor

· Click the Process Monitor link. 

· Click the Refresh button to update the status. (When completed, the Run Status will read “Success”). 

· Click the Go back to… link to return to the Run Control page.


Report Manager

· Click the Report Manager link. 

· Click the Administration tab. 

· Click the Refresh button to update the status. (When completed, the Status will read “Posted”).

· Click the List tab, then the Go back to… link to return to the Run Control page.

If the report displays a status of “Error,” click the Message Log or View Log/Trace link to determine the cause of the error. You will need to re-run the report in order to view the requested data, as a status of Error indicates the report did not complete. 

Accessing Reports

There are three ways to access a report in order to view, print, or otherwise manipulate the resultant data from a report:

· My Reports Pagelet

· Report Manager

· Process Monitor

Step 5 – View, print, or manipulate report data

Each of the methods listed has benefits or conveniences associated with it for viewing or manipulating report data, but personal preference will dictate which method you use to accomplish these tasks. 

Reporting Pagelet

The Reporting pagelet lists the reports available to you. You can access any of the reports by simply clicking directly on the name of the report, or by clicking the Report Manager link, which will allow you to access any of the reports, as well as all other reports available to you that were run within the last five calendar days. 
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Click the report name to open the report with the associated software program. 

To add the My Reports pagelet to your home page:

1. From the SABHRS Financials home page select the Content link
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2. Select the My Reports checkbox then select the Personalize Layout link
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3. Select the 3 column layout, then highlight My Reports currently under the Left Column and select the move right arrow (above the Delete Pagelet button) to move My Reports to the Right Column. Click the Save button and click the Return to Home link.
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Report Manager

The Report Manager lists each report request and the time the request was made to run the report. This list will include those reports you have run, as well as those that were run for you by someone else. Only those reports that completed successfully will be listed in the Report Manager. To view what time recurring reports are scheduled to run, or to view reports that did not successfully run, you must go to the Process Monitor. 

You can access the Report Manager several ways: 

· Click the Report Manager link on the My Reports pagelet; 

· Navigate through the Menu: Reporting Tools > Report Manager > List or Administration tab; or 

· Click the Report Manager link on the Run Control page of any report. 

The List tab tells you the name of the report, when the report successfully completed, and the process instance number for the report. 

The Administration tab details which reports have run (or have been run for you) in the last five days, the process instance number for each report, when the report was requested, and the report format and status. 
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Clicking the Refresh button will update the status of the report. The following is a list of the indicators you may see when checking the status of your report. You will see some subtle terminology differences between the Process Monitor and Report Manager. 

	Status
	Description

	Queued
	Report is scheduled, or about to commence

	Initiated
	System has begun to process report request

	Processing
	Currently in progress

	Scheduled or Queued
	Report will run at a future date/time

	Posting
	Repositories are being updated with report information

	No Success or Error
	Process failed

	Posted or Success
	Process completed successfully


You may view the report by clicking the link in the Description column or the Details link, however, these links will only appear after the report has completed successfully.

The Report Detail page displays the name of the report and the associated output and message log links. Clicking the name of the report displays the report in a new window. You can print the report by clicking the Print button in the browser bar. If the report is in PDF format, you must use the print icon in the Adobe Acrobat toolbar.
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Click the name of the report to view the report. 
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The Administration tab of the Report Manager also allows you to select and delete any report from the list. To delete a report, check the Select box next to the offending report and click the Delete button.
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Deleting the report will delete it for ALL users who have access to it, including those people who received a copy of the report through the Distribute To function. 

To confirm that you really wish to delete the report, the following message appears:
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Click Yes to delete the report; click No to cancel the action. 

To distribute the report to another user after the report has completed, click the Details link. 
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To allow another user to access the report, click the Add a new row button [image: image31.bmp], enter the user ID of the person you wish to grant access, and click the OK button. Continue adding rows and entering user IDs for each person to whom you want to grant access to the report. When finished, click the OK button. 
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Similarly, you can delete a user’s access to the report by clicking the Delete Row button [image: image33.bmp] next to that user’s ID.

Process Monitor

Process Monitor lists each report request and the date and time the report started running, completed, or is scheduled to run. Access the Process Monitor by:

· Navigating through the menu: PeopleTools > Process Scheduler > Process Monitor; 

or

· Clicking the Process Monitor link on the Run Control page of any report. 
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Once the report has completed and the Run Status of “Success” is displayed, click the Details link to go to the Process Detail page.
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Click the ViewLog/Trace link from the Actions list to view the report. Your report will be displayed as a link in the File List and will include the process instance number and the two- or three-digit extension of the format type you selected (e.g., PDF, LP, XLS, etc.). Clicking the report name will open a new window and display your report with the associated software. 
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Scheduling a Report

Recurrence

Reports can be scheduled to run at a future date, multiple times, or at the same time on a regular basis. To set a schedule for the report to run, navigate to the report you wish to run, enter a run control and the desired report parameters, and click the Run button.

The default setting for recurrence is none, as many reports will be run infrequently or on an as-needed basis. On the Process Scheduler Request page, select one of the pre-defined recurrences available from the recurrence dropdown list and click the OK button.  
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As with a non-scheduled report, you can distribute a scheduled report to other users. To allow another user to have access to the report, click the Distribution link.  

Check Report Status

Similar to any other report, the status of scheduled reports can be checked through the Process Monitor or Report Manager. Scheduled reports will appear with a status of “Queued” until the report has completed. The Process Monitor shows when the report is scheduled to run, or when it began running. In the Report Manager, the Administration tab shows when the report was requested, and the List tab displays when the requested report completed. 
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Postpone or Delete Scheduled Reports

Reports that are scheduled to run and in a “Queued” status can be deleted, held, queued, or restarted at any point through the Process Monitor. To postpone the report, navigate via this path:

PeopleTools > Process Scheduler > Process Monitor
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You can begin the process to postpone the report by either clicking the Details link or by clicking the Recurrence icon [image: image40.bmp]. 

If you choose to click the Recurrence icon, you may postpone the report by clicking the Hold button. At a future time, you may return to this page and click the Restart button to begin generating the report again, if desired. You may also stop the report from recurring altogether by clicking the Stop button. 
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If you choose to click the Details link to postpone the report, you may postpone the report by clicking the radio button next to the Hold option in the Update Process section. At a future time, you may return to this page and select Restart Request or Queue Request to begin generating the report again, if desired. You may also stop the report from recurring by clicking the Cancel Request radio button. 
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For reports that have not been scheduled but have been queued or processing for an abnormally long time, you may cancel the request here by clicking the Cancel Request radio button and then clicking the OK button. 

Running a Query

A query is a reporting tool that allows extraction of data from the database tables. An efficient method of gathering the desired information from those database tables is to run a query. To run a query, navigate to the Query Viewer:


Reporting Tools > Query > Query Viewer
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You can search for a specific query by entering the first few characters of the query name in the text field, or click the Advanced Search link for more search parameters. 
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You may use the drop down arrows to select more search criteria, such as “contains, between, not =,” or by Folder Name.  All queries have been sorted into the appropriate folders by module (e.g., AP, GL, AM, etc.). 

Click the Search button to retrieve the queries.
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Add a query to your Favorites by clicking the Favorite link in the associated row. 

In the future, you can run your most often used queries without having to search for them first – simply click the appropriate link.
Output Options

Query results can be obtained either by running the query to an HTML window, or by running the results directly to Excel. Each method has various benefits, as follows:

	Method
	Advantages
	Disadvantages

	HTML
	Can print viewable data from here.
	Can’t perform any data manipulation. 

	
	Can use print preview.
	Can’t sort.

	Excel
	Data is formatted.
	Must “Save As” an .xls file if you want to save your data.

	
	Leading zeroes appear. 
	Must close or save current worksheet in order to re-run same query with different criteria.


[image: image73.wmf]Note: If you are running a query that will return a large number of rows (more than 65,000, for example), you should schedule the query as a .txt file to allow for the most efficient use of system resources. When complete, save the file and open with Notepad.
Run to HTML

Click the HTML link associated with the query you wish to run. Note that in most cases, the parameter fields cannot be blank. If you want all values for a specific field, enter a wild card character (%). Enter your search criteria and click the View Results button.
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To re-run the query with different parameters, change the criteria and click the View Results button. 

[image: image74.wmf]Results of a query will not be saved in the Report Manager or Process Monitor unless the query was scheduled. If you wish to save the results, you must download them into an Excel or .csv file and save it to your local or network drive.

Although your initial selection was to run to an HTML window, you may still download the results of your query to Excel with formatting (as an Excel spreadsheet), as a CSV file, or as an XML file by clicking the appropriate link.
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Clicking the Excel SpreadSheet link or the CSV Text File  link, the following message appears, prompting you to either open or save the file:
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Clicking “Open” will open Excel and display the query results. 

Clicking the “Save” button will display another dialogue box, prompting you to enter the file name and location of where you want the spreadsheet saved. 

Run to Excel

Click the Excel link to obtain desired query results in an Excel spreadsheet. 
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Enter your search criteria into the new window that displays and click the view results button. Most queries require a value to be entered into every field, although if you wish to retrieve all values for that field, you may use a wild card character (%).
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Clicking the View Results link will launch the Excel program (if not already open) and display your results in an Excel spreadsheet with the total number of rows listed in cell B1. 
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Tip: Be sure to save or close the Excel spreadsheet before exporting more results or attempting to run the same query with different parameters.  

Scheduling a Query

Similar to scheduling a report, you can also schedule a query with recurrences or to run at a single future date and time. You can schedule queries to run both through the Query Viewer as well as through the Query Scheduler. 

The description you enter will show up in the Process Monitor and Report Manager if you schedule the query through Query Scheduler, but not if you scheduled the query through Query Viewer. 

Schedule through Schedule Query

To schedule a query through the menu option Schedule Query, navigate to:

Reporting Tools > Query > Schedule Query.

Run Control IDs are specific to queries, so if you are scheduling a query for the first time, you will need to add a new Run Control ID, otherwise you can search for an existing one.
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Select a query to run by entering the query name or the first part of the query name, and then clicking the search button. 
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When you have selected a query, a new page appears, prompting you for the parameters. 

Enter the parameters and click the OK button to return to the Schedule Query page.
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Enter the description you wish to appear in the Report Manager for this query and click the Run button. 

Identical to the screen in running reports, the Process Scheduler page prompts you for various selections, including run time, recurrence, output type, and format fields. 
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Enter the desired run date, recurrence, type, format, and distribution recipients and click the OK button. Check the status or view the results of your query via your preferred method (e.g., Process Monitor or Report Manager) as discussed previously. 
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Schedule through Query Viewer

To schedule a query through Query Viewer, navigate to:

Reporting Tools > Query > Query Viewer.

At the Find an Existing Query page, search for the desired query. You can search by entering the first few characters of the query name in the text field, or click the Advanced Search link for more search parameters. 

To schedule the query, simply click the Schedule link in the associated row. 
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Select an existing Run Control ID, or add a new one, if this is the first time you have scheduled this query. Run Controls may be re-used each time you schedule the query.
Fill in the parameters for the desired results and click the OK button. 
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In most cases, you must enter a character in every field. If you want all values for a given field, type a wild character (%) into that field. Click the OK button.
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Enter the desired run date, recurrence, type, format, and distribution recipients and click the OK button. Check the status or view the results of your query via your preferred method (e.g., Process Monitor or Report Manager) as discussed previously.

Data Mine

Background

The SABHRS Data Mine is a custom-developed application that loads Excel pivot tables to summarize data from various ledgers within the Financials system. The purpose of the SABHRS Data Mine is to provide an enterprise solution that addresses users’ financial and budgetary data access and analysis needs. Since the data is summarized, no drill down is available through the SABHRS Data Mine, however users can already drill down through numerous other inquiry pages within SABHRS. 

The SABHRS Data Mine is available to all Financials users, both through a direct link directly from the Mine portal, as well as from within the Financials application.

The SABHRS Data Mine includes six workbooks with a total of 34 pivot table reports.  

Overview

Special reporting tables are updated nightly after the Financials batch processing has completed, although during Fiscal Year End, the reporting tables may be updated more frequently, as necessary. 

When the user runs reports from the SABHRS Data Mine, data is retrieved from the special reporting tables and loaded into one or more data sheets within an Excel workbook. 

Reporting pivot tables are created based on the data sheets, and can be refreshed individually or all at once. Fields from the data sheet are brought into the Page, Column, Row, or Data area of the pivot table, or left on the menu for retrieval by the user. 

Features

Not only is the SABHRS Data Mine easily accessible with information that is refreshed nightly, and can provide as much information as allowed by Excel spreadsheet maximum limits, but it also makes possible the ability to:

· Report across fiscal years

· Report across business units

· Customize completed reports to meet individual agency needs

· Identify specific selection criteria, whether basic or complex

· Easily select and analyze data

Setup

In order to use the Data Mine, users must have access to the Mine portal, the Microsoft Excel application installed on the their computer (and some knowledge of Excel), and have configured the following file settings:

· “Browse in Same Window” is de-selected for XLS file type (see p.4) 

· Excel macro security is set to Medium (recommended) or Low
Detailed instructions on this configuration can be found by clicking the Downloading to Excel Help link on the SABHRS Data Mine Main Menu page.


Before calling the help desk, double, triple, and quadruple check these settings; without them set accordingly, the Data Mine will not function!

Basic Steps

Before running a new report, close or save any reports that were previously run. 

Log into the SABHRS Data Mine by either clicking the SABHRS Data Mine link in the Mine menu, or from within Financials, navigate to:

General Ledger > SABHRS Data Mine > SABHRS Data Mine

Select the desired workbook by clicking the associated radio button. A complete list of workbooks and the delivered pivot tables for each is included at the end of this document.
Enter the desired criteria and click the Load Excel Workbook button. 
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Click “Yes” when the following message appears:
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Excel launches (if not open already) and displays the menu page of the requested workbook. 
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Users can refresh all pivot tables by clicking the Refresh All Pivot Tables button, or by navigating to the desired report and clicking the Refresh link. 
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Upon clicking the Refresh link, all related pivot tables will be refreshed, as well. 
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Raw data is provided in the data sheets at the end of the workbook, should you decide to create your own pivot tables or use advanced Excel functions such as Autofilter, Subtotals, etc. Users may optionally print or save the workbook, is desired. 

While users may print and/or save the report, the files will be very large (up to 20M in size); therefore a lot of disk space can be used up very quickly. You may wish to save one file to a shared location for viewing by others. 

Helpful Hints

· Use the lookup buttons [image: image65.bmp] to determine valid values. 

· The More Criteria area must be visible (not collapsed or “hidden”) to be in effect. 

· To get all values, use the wild character (%), not a blank or space.

· Blank means blank (no value entered). Only leave the field blank if you are specifically looking for blank values. 

· You can create or delete criteria IDs, to store different report parameters for each report. 

· Changes to the From/To Accounting Period/Fiscal Year are not saved. The default is the current year-to-date.

· To include the carry forward amount in the Account Balances worksheet, select Accounting Period 0 in the From Range. 

· Double click on a dollar amount for more detail. 

· Bonus hint: To get rid of the new detail sheet that appeared, right click and select delete. Simply closing that sheet will close the entire workbook!

Query Development

If you wish to create your own queries using the data available through the SABHRS Data Mine, you can use the following views:

	Record
	Description

	LEDKKLED_VW1_N
	Data Mine—Queries Ledger Expenditures, Project Budgets, Project Budget Expended Amounts (LEDGER_KK, LEDGER).  In the Data Mine, used in the Project Budgets workbook to compare Projects Budgets to PRMST_EX expended amounts and Actuals expended amounts.  (OPI only)

	LEDKKSB_VW1_N
	Data Mine—Queries APPROP Budgets, ORG Budgets and Standard Budgets for Comparison Purposes (LEDGER_KK , LEDGER_BUDG).  In the Data Mine, used for Budgets Comparison report within the Standard Budgets workbook

	LEDKK_RPT_VW1_N
	Data Mine---Queries APPROP Budgets, ORG, Budgets, REV/EST Budgets, REV/EST Recognized Amounts (LEDGER_KK).  In the Data Mine, used in the APPROP/ORG/REV workbook to compare REV/EST Budgets amounts to the REV/EST amount recognized.

	LEDLEDKK_VW1_N
	Data Mine---Queries Ledger Revenues and Expenditures, APPROP Budgets, ORG  Budgets (LEDGER, LEDGER_KK).  In the Data Mine, used in the APPROP/ORG/REV Budgets workbook for comparing Budgets to Actuals expended.

	LEDSB_VW1_N
	Data Mine---Queries Ledger and Standard Budgets (LEDGER and LEDGER_BUDG).  In the Data Mine, used in the Standard Budgets workbook to compare Standard Budgets to Actuals expenditures

	LED_RPT_VW1_N
	Data Mine---Queries all accounts from Ledger (LEDGER).  In the Data Mine, used for Account Balances reports, Revenues/Expenditures, and Projects reports.


Appendices

Bonus Features in Adobe Reader 6.0

Search Utility

Most reports can be run to a PDF file that can be viewed in Adobe Acrobat Reader 6.0 (and later). Adobe has some great search features you can use within your report. If you have an older version, you can download the latest version for free at www.adobe.com.

Click the Adobe search icon (binoculars) to display the search pane and enter the specific value for which you wish to search within the document.
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Note that the Adobe icons are in a separate toolbar, and are not on the browser toolbar!

The results column lists all the occurrences of your search criteria in the document and provides hyperlinks to that page in the report. By hovering over the link (point, but don’t click), you can see the page number on which the value was found. Contextual information is also listed next to each search result. 

Select Text Utility

Previously, documents in PDF format were protected as read-only, and users were prevented from selecting and copying data into any other document. The current version of Adobe provides a text-select tool, however, that allows you to copy information from an Adobe document into another program such as Word or Excel. 

[image: image67.png]" https://doaisdvm164.isd. doa.state.mt. us:

Fle Edt GoTo Favorles Help

dress 6] tpsfidoistvmics . coa.state s

Blsweacor () @, P sewon||

O M B G| Pt Forownss €

541/psreports/fsB4tr/95733/MTGL1101_180410.PD]

-[Cl

D | R &

icrosoft Internet Explorer

JmRoy <Jeal

Jfs34tr]95733/MTGL101_180410.PDF

7%

- ® [103-

R

L

VB s>

2 e o

BepatD: MTGLIOL

Stateof Montara. Pt 1a 1

Irberuni Journals in Process Report

R 70005

prrr e —

ke HITfo s s, 1By Lowk S
omace pykeLegsbupe uk Do fa TjetD L14677]
el

HETO - Pt festo LD, Quetins? ll Tt 2599,
BT Pt festo LAD. Quetis? Cll Tt 2599
TS Pt festo LAD.Quetis? Cll Tt 2520

o wl st . Qi Col o 17

Pt fusto 4D, Qesins? Call Tt Y5356
gt festo LD, Qesins? Call Tk Y53,
gt fusto 4D, Qesins? Call Tt Y535

Dayivg nudk foeeto L AD, Quedtians? Call Trida 1599,

>




Simply click the Select button in the Adobe toolbar, and select the desired text by clicking and dragging over it. Right click and select Copy, then go to the destination program, right click again, and select Paste. The selected information will copy into the new document, allowing you to better format, sort, move, and manipulate the information.

Financials Report Output Options Guide
As of 09/06/2011
 



                (highlighted rows are recommended methods)


When 
Output Type of WINDOW is selected, a new window will open with the report displayed.  When WEB is selected, the report can be accessed through the Process Monitor.  Reports run either to WINDOW or WEB can be accessed in Report Manager until they expire. XMLP reports are viewed in Report Manager.

	Report Type
	Output Type
	Output Format
	Advantages
	Disadvantages
	Comments

	Crystal
	Window/Web
	PDF
	Use Adobe Reader to Print, Rotate, Find, etc.
	
	Using the search capabilities in Adobe Reader can be very useful.

When saving or printing a PDF file that opened in a new window, be sure to use the ADOBE icons, not the browser icons.

	Crystal
	Window/Web
	TXT
	Can SAVE AS a TXT file to use with DocuAnalyzer.
	Crystal formatting is lost.
	

	Crystal 
	Window/Web
	XLS
	The report will open up directly in Excel.


	Crystal formatting is lost.
	Make sure CSV file type is associated with Excel.

	Crystal
	Window/Web
	RTF
	Can save as Word or RTF (Rich Text Format).  MS Word can open up either.


	
	Need for printing GL Journals.  



	
	
	
	
	
	

	SQR
	Window/Web
	PDF
	Use Adobe Reader to Print, Rotate, Find, etc.


	

	Using the search capabilities in Adobe Reader can be very useful.

When saving or printing a PDF file that opened in a new window, be sure to use the ADOBE icons, not the browser icons.

	SQR
	Window/Web
	LP
	Can use with DocuAnalyzer.


	Running to the window will not open the report in the window, but display the LIS report link. Click the link to view the report.
	Must access the file in the window and SAVE AS text file.

	SQR
	Window/Web
	CSV
	Goes right to Excel.
	Lose formatting.
	If running to a WINDOW and Excel is already open, it may not be apparent when the report has finished.


	
	
	
	
	
	

	XMLP
	Web
	PDF
	Use Adobe Reader to Print, Rotate, Find, etc.


	
	Using the search capabilities in Adobe Reader can be very useful.

When saving or printing a PDF file that opened in a new window, be sure to use the ADOBE icons, not the browser icons.

	XMLP
	Web
	LP
	Can use with DocuAnalyzer.


	
	Must access the file in the window and SAVE AS text file.

	XMLP
	Web
	XLS
	Goes right to Excel.
	
	

	XMLP
	Web
	HTM
	
	
	

	XMLP
	Do not select types of email, file, or printer.
	
	
	
	

	
	
	
	
	
	

	Query
	Run to HTML
	Window
	To re-run the query, change the parameters and click the View Results button.

Can print viewable data.

Can use print preview.
	Cannot sort results.

Cannot perform any data manipulation.
	Can download as an Excel or CSV text file by clicking appropriate link. 

	Query
	Run to Excel
	Excel
	Data is formatted.

Leading zeroes appear (e.g. Fund, Journal ID, etc.).

Query Name and number of rows appears at top of page.
	Must “Save As” an .xls file if you want to save your data.

Must close or save current worksheet in order to re-run same query with different criteria.  (You WON’T get an error message).
	Recommend saving or X-ing out of original query results before running the query again.

If Excel is already open, sometimes query results go there and you don’t even know it— you have to click on your Excel window to view.



	
	CSV Text File  (after running query to HTML)
	
	Takes you directly into Excel.

Wrap text and merge cells not an issue.
	Drops leading zeroes (i.e. Fund, Journal ID, etc.).

Lose formatting.

If you run the same query a 2nd time, the results will go to Excel, creating a new window each time.

~ OR ~ 

The results won’t go to Excel unless you X-out of the 1st query results in Excel or save the 1st query results to a file within Excel.  (You WILL get an error message).
	Recommend saving or X-ing out of original query results before running the query again.

If Excel is already open, sometimes query results go there and you don’t even know it— you have to click the Excel window to view.

Make sure CSV file type is associated with Excel.

The CSV option is only available AFTER running the query to HTML. To save an extra step, click the Run to Excel link when initially running the query.

	Query
	XML
	
	Useful if using Web services
	Searching for specific data is tough
	

	
	
	
	
	
	

	App

Engine
	Web
	TXT
	
	
	


Running and Viewing a Report
· The purpose of this task is to run and view a report in SABHRS.
· All reports can be scheduled with or without recurrences.  
· Reports can be distributed to other users, and are available on Report Manager for 5 days.
	
	
	STEPS
	Comments/Notes/Navigation 

	
	
	Select Report to Run
	

	1
	
	Navigate to the report you want to run.
	Use the menu or select from My Favorites.

	2
	
	Select an existing or add a new run control.
	Because run controls are dynamic, it is suggested that you use a separate run control for each report.  In some cases, you may have many run controls saved for a specific report.

	3
	
	Select chartfields to include in the report.
	NOTE: On reports that have chartfield parameters, you may need to click the Refresh button to expand and see all the chartfields.

	4
	
	Input any required parameters and click the Run button.
	The wild card character (%) may NOT be used in chartfields that have the Value From and Value To fields. 

	
	
	Complete Process Scheduler Request
	

	5
	a.
	Leave Server Name field blank.
	Do not select a server name from the drop down list.  

	
	b.
	Choose a run date and time.
	These fields default to the current date and time.  If you wish to schedule the report for a later date/time, enter the future date and time desired.

	
	c.
	If desired, choose a recurrence from the Recurrence drop down list.
	If you want the report to be run over and over at a specific time of the week/month, select a recurrence.  If distribution to others is selected in the initial run of the report, the same distribution will occur in the recurrences.

To delete a recurrence, go to the Process Monitor and click the Details link next to the next scheduled report.  Click the radio button next to HOLD REQUEST or Cancel REQUEST.

	
	d.
	Ensure the select box is checked for the process you want to run.
	

	
	e.
	Choose an output type from the Type drop down list.
	Web – goes to Report Manager and Process Monitor.

Window – runs in a new window and to Report Manager and Process Monitor. 

Email – the report is distributed in an email (careful when running a large report so that it does not exceed the email file size limitations)

	
	f.
	Choose an output format from the Format drop down list.
	SQR options:

· CSV (Comma Separated Variable) – view in Excel (no formatting).
· LP (Line Printer) – view as a text file in DocuAnalyzer, Textpad, or Notepad. 

· PDF (Portable Document Format) – view in Adobe Acrobat.
CRYSTAL options:

· PDF  – view in Adobe Acrobat.
· RTF (Rich Text Format) – view in Word.
· TXT (Text File) – view as a text file in DocuAnalyzer, Textpad, or Notepad.
· XLS (Microsoft Excel) – view in Excel.
XMLP options:

· HTM 

· PDF  – view in Adobe Acrobat.
· RTF (Rich Text Format) – view in Word.
· XLS (Microsoft Excel) – view in Excel.

	
	g.
	Click the Distribution link to distribute the report to other users.
	By default, your user ID will automatically populate the appropriate fields. Add other users by inserting rows and entering or selecting their user ID.  

The Email section does not apply.  

Click the OK button to return to the Process Scheduler page.

	
	h.
	Click the OK button.  
	Note the process instance number displayed in the upper right hand corner of the page.

	
	
	View the report
	Click either the Process Monitor or the Report Manager link. 

	6
	
	Process Monitor – shows all reports that tried to run, even those that did not complete.
	

	7
	a.
	Check Run Status.
	Click the Refresh button to update the page.  

You may select type, name, process instance and/or run status.  Select number of days, hours, etc. you want to see.  Reports that fit the specified criteria are displayed, listed in descending order by run date and time.

	
	b.
	Click the Details link.
	Click the Message Log link to view errors, if any, with running the report.

Can cancel or delete a request by clicking the request.

	
	c.
	Click the View Log/Trace link.
	

	
	d.
	Click the report name. 
	Report name ends in the 2 or 3-digit extension of the file type you selected (e.g., PDF, XLS, RTF, etc.)

	
	
	Report Manager – shows the status of all reports and some processes run within the last 5 days plus all extended reports.
	Navigate to Reporting Tools > Report Manager ~ OR ~

Click the Report Manager link in the reporting pagelet.

	9
	a.
	List Page – Lists only reports that have posted to Report Manager.
	Default page.  You may specify the reports you wish to view by selecting/entering the process instance number, name, created-on date, and/or number of days you want to see.  Click the Refresh button to update the page.

Reports are listed in descending order based on when they completed running.

Shows a description of the report.

Click the report ID to view the report.

There is no link back - you must use the browser Back button or click the Report Manager menu link.

	
	b.
	Explorer Page - Lists reports by folder hierarchy – currently only General folder.  
	Click the folder to view the list.  No description of report is provided.  Click the link to the desired report to view the report.

	
	c.
	Administration Page – Lists all reports that are posted or processing in descending order by the date/time of the when the report was requested to run.
	Details link – 

· Distribute the report to other users by inserting rows, entering user ID, and then clicking the OK button.  
· Extend the life of the report by changing the expiration date.  (Users should only extend the life of the report when absolutely necessary)
Description link (Report Name) – Click and a new window will open displaying the report.

Can delete a report by selecting the line, then clicking the Delete button.  If the report is distributed to other users, deleting it will delete it for everyone that received it.

	
	d.
	Archives – not used.
	


 Running a Query
Overview
· The purpose of this task is to run and view an existing query in SABHRS.

	
	
	STEPS
	Comments / Notes / Navigation

	1
	
	Access the Query Viewer Component
	Reporting Tools > Query > Query Viewer

If set up, any Query Favorites will immediately appear upon entering the Query Viewer page

	2
	
	Find an Existing Query
	

	
	a.
	Using Basic Search – 

· Click the Search By drop down arrow and select the field by which you wish to search (Query Name, Description, Folder Name, Owner (Public or Private), Uses Field Name, Uses Record Name).

· Enter/choose selection criteria for the field

· Click the Search button.
	

	
	b.
	Using Advanced Search –

· Click the Advanced Search link.

· Enter selection criteria for any of the listed fields.

· Click the Search button.
	

	
	c.
	Using Favorites –

· Once established, Query Favorites will automatically appear upon entering Query Viewer.

· To add a query to your list of favorites, search for the query, and then click the Favorites link next to the query name. 
	To delete a favorite query, click the Remove icon in the Remove column next to the query.

Favorite queries will also appear in the My Favorite Queries section below the query search results.

	
	d.
	Using Folders –

· In the Basic or Advanced Search, enter folder name criteria using the Folder Name field, ~ OR ~

· After a search, choose a folder name from the Folder View drop down list.
	Queries are organized into folders by subject.  For example, folder names begin with AP, GL, AM, AR.

NOTE:  Queries and folders available from the folder view drop down are within the original search criteria.

	3
	
	Run the Query
	

	
	a.
	Run to a Window – 

· Click the HTML link in the row of the query you wish to run.

· Enter the parameters for the query.

· Click the View Results button.

· View results as they appear on your screen.

· View/manipulate results in Excel by clicking the Excel Spreadsheet or CSV Text File link in the Download results in: section.
	A new window will open.

Do not leave a parameter field blank. If you wish to retrieve all information for that field, enter %.

You can print retrieved rows by clicking the browser print icon.

Query results with large amounts of data should be scheduled or downloaded as CSV.  Otherwise, an error may occur.



	
	b.
	Run to Excel – 

· Click the Excel link in the row of the query you wish to run.

· Enter the parameters for the query.

· Click the View Results button.

· View results in Excel.
	If Excel is already open, then you’ll need to go to the Excel window to view your results.  If Excel is not open, then Excel will launch and the results will appear in the new Excel window.

NOTE:  Large query results cannot be run directly to Excel.  The user may receive an error.  Instead, either schedule the query or run the query to a window (Run to HTML) and download as a CSV file.

See Reports and Queries manual for screen shots and more details.

	
	c.
	Schedule the Query (option 1) – 

· Click the Schedule link in the row of the query you wish to schedule.

· Select an existing or add a new run control.

· Enter/update the query parameters (and a description, if you’re adding a new run control).

· Click the OK button (the Process Scheduler window will display).

· From the Format drop down list, select XLS (creates formatted Excel file) or TXT (creates CSV file).

· Choose other report parameters from the process scheduler window, if desired.

· Click the OK button.

· Navigate to the Process Monitor or Report Manager to access your query results:

· In Process Monitor…

· Click the Details link.

· Click the View Log/Trace link.

· Click the XLS or CSV file link.

· In Report Manager…

· On the List tab, click the report name link.

· Click the XLS or CSV file link.
	NOTE:  Only 6 parameters are displayed on the page.  Click the Update Parameters link to view all parameters and update their values.

Schedule queries when…

· You want the query to run in the future;

· You want the query to run with recurrences;

· The query results are too large to download from a browser window;

· The query results are too large to run directly to Excel; or

· When you want to view the query parameters in Excel.



	
	d.
	Schedule the Query (option 2) – 

· Navigate to Schedule Query.

· Select an existing or add a new run control.

· Enter or search for a query name.

· Enter/update the query parameters (and a description, if you’re adding a new run control).

· Click the Run button (the Process Scheduler window will open).

· Perform remaining steps from section C, above. 

	Reporting Tools > Query > Schedule Query


Data MINE Reports

(updated 01/18/2005)

	Workbook
	Report Worksheet
	Description
	Comments, Hints, and Tips

	Revenue/Expenditures

(10 reports available)
Reports expenditure and revenue amounts from a specified ledger.  The default is the Actuals and A Accrual ledgers.
	Exp by Org
	Expenditures by Org
	

	
	Exp by Account
	Expenditures by Account
	

	
	Exp by Org, Account
	Expenditures by Org, Account
	

	
	Exp by Fund
	Expenditures by Fund
	

	
	Exp by Subclass
	Expenditures by Subclass
	

	
	Rev by Fund
	Revenue by Fund
	

	
	Rev by Account
	Revenue by Account
	

	
	Rev by Fund, Account
	Revenue by Fund, Account
	

	
	Rev-EXP by Fund, Org
	Revenue less expenditures by Fund, Org
	

	
	Rev-EXP by Org, Account
	Revenue less expenditures by Org, Account
	

	
	
	
	

	Approp/Org/Rev Budgets

(6 reports available)
Reports Approp, Org, and Revenue Estimate budgets compared to expenditures from the Actuals and A Accrual ledgers and revenue recognized from the budget ledger (LEDGER_KK)
	ORG Bud by OBPP Prog, Fund, Subclass
	Org budgets by OBPP Program, Fund, Subclass compared to Actuals/A Accrual expenditures
	

	
	ORG Bud by OBPP Prog, Subclass, Fund
	Org budgets by OBPP Program, Subclass, Fund compared to Actuals/A Accrual expenditures
	

	
	ORG Bud by OBPP Prog, Source of Auth
	Org budgets by OBPP Program, Source of Authority (HB2, HB576, etc.) compared to Actuals/A Accrual expenditures
	To view details, double click on the non-HB2 group. (The first time, you will need to select the field for which you wish to see details—usually Source of Auth). Double click again to summarize.

	
	ORG Budgets - No A Accruals
	Org budgets compared to compared to Actuals expenditures
	Use this report to view Org budgets compared to Actuals expenditures only without A Accruals.

	
	APPROP Bud by OBPP Prog, Subclass, Fund
	Approp budgets by OBPP Program, Subclass, Fund compared to Actuals/A Accrual expenditures
	

	
	REV/EST Bud by Org, Fund, Account
	Revenue Estimate budgets by Org, Fund, Account compared to recognized amount on the budget ledger (LEDGER_KK)
	

	
	
	
	

	Standard Budgets

(4 reports available)
Reports Standard Budgets compared to expenditures from the Actuals and A Accrual ledgers.
	Budgets Comparison
	Compare APPROP, ORG, and Standard Budget amounts.
	Use this report to determine whether APPROP and ORG budgets match or whether Standard Budgets match ORG budgets.

	
	Standard Budgets by Org, Account
	Standard Budgets by Org, Account compared to Actuals/A Accrual expenditures
	

	
	Standard Budgets by Org, Fund, Account
	Standard Budgets by Org, Fund, Account compared to Actuals/A Accrual expenditures
	

	
	Standard Budgets by Org, Account, Month
	Standard Budgets by Org, Account, Month compared to Actuals/A Accrual expenditures
	To see data by month, check the “Show Acctg Per Detail”


	
	
	
	

	Account Balances

(3 reports available)
Reports any ledger account balances from the Actuals and A Accrual ledgers.
	Account Balances
	Reports balance of any account.  Similar to the Trial Balance report.
	** To include the beginning balance, choose “From” Period 0 on the criteria page.  (default)

	
	Balance Sheet
	Reports assets and liabilities and groups equity, revenues and expenditures together in one report
	Double click on the Equity+Revenue+Exp group to view details.  Double click again to summarize.

** To include the beginning balance, choose “From” Period 0 on the criteria page.  (default)

	
	Income Statement
	Compares revenue and expenditures by fund.
	

	
	
	
	

	Projects

(9 reports available)
Reports expenditure and revenue amounts by project from a specified ledger.  The default is the Actuals and A Accrual ledgers.

This workbook is similar to Revenues/Expenditures except that the Project chartfield is in the row area of the pivot table.
	Exp by Project
	Expenditures by Project
	

	
	Exp by Project, Fund
	Expenditures by Project, Fund
	

	
	Exp by Project, Account
	Expenditures by Project, Account
	

	
	Exp by Project, Org, Fund, Account
	Expenditures by Project, Org, Fund, Account
	

	
	Exp by Org, Project, Account
	Expenditures by Org, Project, Account
	

	
	Rev by Project, Account
	Revenue by Project, Account
	

	
	Rev by Org, Project, Account
	Revenue by Org, Project, Account
	

	
	REV-EXP by Project
	Revenue less expenditures by Project
	

	
	REV-EXP by Fund, Project
	Revenue less expenditures by Fund, Project
	

	
	
	
	

	Project Budgets

(2 reports available)
Reports Project budgets (PRMST_EXP ledger group) compared to expenditures from both Actuals/A Accrual ledgers and the budget ledger (LEDGER_KK)
	Project Budgets Compared to Budget Expenditures


	Project budgets compared to budget ledger expenditures (LEDGER_KK) by Project.
	OPI is the only agency using project budgets at this time.

	
	Project Budgets Compared to Actuals Expenditures
	Project budgets compared to Actuals/A Accrual expenditures by Project.
	OPI is the only agency using project budgets at this time.
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